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. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.

.Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or

other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.

. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,

manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any

and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

.Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depend on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home
electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key

financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
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Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damage or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.

. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics

hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

.When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.

. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

10.Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11.Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12.1t is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13.This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
14.Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas

Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information

TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-
Koto-ku, Tokyo 135-0061, Japan to-date version of a document, or your nearest sales office,
WWW.renesas.com please visit: www.renesas.com/contact/.

Trademarks

Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered
trademarks are the property of their respective owners.
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Renesas EK-RA8P1

By using this EK-RA8P1, the User accepts the following terms, which are in addition to, and control in the event of disagreement, with Renesas’ General
Terms and Conditions available at https://www.renesas.com/en-us/legal/disclaimer.html.

The EK-RA8P1 is not guaranteed to be error free, and the entire risk as to the results and performance of the EK-RA8P1 is assumed by the User. The EK-
RA8P1 is provided by Renesas on an “as is” basis without warranty of any kind whether express or implied, including but not limited to the implied
warranties of good workmanship, fitness for a particular purpose, title, merchantability, and non-infringement of intellectual property rights. Renesas
expressly disclaims any implied warranty.

Renesas does not consider the EK-RA8P1 to be a finished product and therefore the EK-RA8P1 may not comply with some requirements applicable to
finished products, including, but not limited to recycling, restricted substances and electromagnetic compatibility regulations. Refer to Certifications section,
for information about certifications and compliance information for the EK-RA8P1. It is the kit User’s responsibility to make sure the kit meets any local
requirements applicable to their region.

Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, loss of contract, loss of business, damage to reputation or goodwill, any
economic loss, any reprogramming or recall costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any
other direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this EK-RA8P1, even if Renesas or its affiliates
have been advised of the possibility of such damages.

Renesas has used reasonable care in preparing the information included in this document, but Renesas does not warrant that such information is error free
nor does Renesas guarantee an exact match for every application or parameter to part numbers designated by other vendors listed herein. The information
provided in this document is intended solely to enable the use of Renesas products. No express or implied license to any intellectual property right is
granted by this document or in connection with the sale of Renesas products. Renesas reserves the right to make changes to specifications and product
descriptions at any time without notice. Renesas assumes no liability for any damages incurred by you resulting from errors in or omissions from the
information included herein. Renesas cannot verify, and assumes no liability for, the accuracy of information available on another company’s website.

Precautions

This Evaluation Kit is only intended for use in a laboratory environment under ambient temperature and humidity conditions. A safe separation distance
should be used between this and any sensitive equipment. Its use outside the laboratory, classroom, study area, or similar such area invalidates conformity
with the protection requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio communications. There is no guarantee
that interference will not occur in a particular installation. If this equipment causes harmful interference to radio or television reception, which can be
determined by turning the equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures:

+ Ensure attached cables do not lie across the equipment.

* Reorient the receiving antenna.

* Increase the distance between the equipment and the receiver.

» Connect the equipment into an outlet on a circuit different from that which the receiver is connected.

+ Power down the equipment when not in use.

+ Consult the dealer or an experienced radio/TV technician for help.

Note: It is recommended that wherever possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the following measures be undertaken:
* The user is advised that mobile phones should not be used within 10 m of the product when in use.

* The user is advised to take ESD precautions when handling the equipment.

The Evaluation Kit does not represent an ideal reference design for an end product and does not fulfill the regulatory standards for an end product.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must
be taken to stop the generation of static electricity as much as possible and quickly dissipate it when it occurs. Environmental control must be adequate.
When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices
must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work
benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare
hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2.Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin,
the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a
product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at
which resetting is specified.

3.Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-
up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow
the guideline for input signal during power-off state as described in your product documentation.

4.Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in
the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.
5.Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a
reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an
external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6.Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VL (Max.)
and Vix (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is
fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi4 (Min.).

7.Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LSl is not guaranteed.

8.Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The
characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating
margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for
the given product.
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1. Introduction

This Quick Start Guide (QSG) provides a practical introduction to the Renesas RUHMI (Robust Unified
Heterogeneous Model Integration) framework, in which Al compiler is by powered by EdgeCortix® MERA™.
and it is optimized for Renesas RA microcontrollers.

The guide covers:

e Anoverview of RUHMI Framework's key features, including model quantization, compilation, and C
source code generation.

e Step-by-step instructions for installing and running RUHMI Framework in both Linux and Windows
environments.

o Usage of Al application example for deploying TensorFlow Lite, ONNX, and PyTorch/ExecuTorch
models with optional acceleration using Arm® Ethos-U55.

e Usage of RHUMI framework with your Al model and your project.

1.1 Assumptions and Advisory Notes
To use RUHMI Framework effectively, the following conditions and knowledge are assumed:

1. Tool experience: Users are expected to have prior experience with embedded development and Al
model training using frameworks such as TensorFlow or PyTorch/ExecuTorch.

2. Model access: It is assumed that users already possess or have access to pre-trained models in
TensorFlow Lite (.tflite), ONNX (.onnx), PyTorch/ExecuTorch(.pte) format.

3. Subject knowledge: Familiarity with microcontroller-based systems, C programming, and Renesas
Smart Configurator tools are required.

4. Supported platforms: RUHMI Framework targets Renesas RA family MCUs. Optional support for the
Arm® Ethos-U55 NPU is available through the Arm Vela compiler. Verify hardware compatibility
before use.

5. Software versioning: Always use the latest version of RUHMI Framework to ensure compatibility with
supported models, libraries, and runtime tools.

6. Screen references: Figures and Ul examples in this guide are for reference only. Actual screen
layouts or paths may differ depending on the software version.

R11QS0065EJ0101 Page 7 of 32
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2. RUHMI Framework Overview

RUHMI (Robust Unified Heterogeneous Model Integration) Framework is a model deployment toolchain
developed to enable Al model deployment on embedded processors. It enables efficient and scalable
deployment of machine learning models on edge devices with limited memory and power budgets. RUHMI
Framework’s first backend iteration has been optimized to support Renesas RA8 series of microcontrollers
by leveraging a modified version of MERA™2.0 from Renesas partner EdgeCortix®.

RUHMI Framework supports widely used model formats including TensorFlow Lite, ONNX, and
PyTorch/ExecuTorch. It is also capable of deploying models to both CPU-only and CPU+NPU (Arm® Ethos-
U55) configurations.

RUHMI Framework is ideal for real-time applications such as:

[ ) Object detection
L] Speech recognition
) Industrial and consumer edge Al use cases

It is designed to minimize hardware-specific complexity while offering developers a flexible, framework-
agnostic toolchain.

E X O PyTorCh@ ONNX

TensorFlow Lite

RUHMI Al Framework*

Optimize Quantize Partition

k RA8P1 C-code generation (.c, .h) J

e2studio
User Application Code

L MCU Compiler (GCC/LLVM) J

ann
X
b
)
o
-y
manm

IO
* Powered by EdgeCortix® MERA™ 2.0

Figure 21 RUHMI Framework Overview

Key Features of RUHMI Framework

e Supports FP32 (floating-point) and INT8 (quantized) inference

o Automatically partitions operators between CPU and NPU based on hardware constraints

e Generates optimized C/C++ source code for integration into e? studio projects

¢ Uses CMSIS-NN and soft-float libraries for portable MCU inference

e Supports external memory for large models beyond SRAM size

o Built-in quantizer with PSNR-based validation for post-training quantization

e Integrated utilities for reference data generation, runtime testing, and MCU verification

¢ Seamless integration with TensorFlow Lite (.tflite), ONNX (.onnx), PyTorch/ExecuTorch(.pte)
format.

o Compatible with both Linux CLI and Windows CLI / GUI(Al Navigator) environments

The project example included in this guide demonstrates the following:

R11QS0065EJ0101 Page 8 of 32
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Import of a pre-trained Al model in the supported format

Post-training quantization using RUHMI Framework's built-in quantizer
Compilation into optimized C source code for Renesas RA8P1 platform
Generation of input/output reference data for validation

1
2
3
4
5) Deployment and execution on an evaluation board via Renesas e? studio

NN N S~
~— ' — — ~—

You can get the software, the technical documentation and the application example project from GitHub
repository, renesas/ruhmi-framework-mcu: Renesas RUHMI Framework supports Al model optimization and
deployment, and is powered by EdgeCortix® MERA™

3. Running RUHMI Framework with Windows GUI: Al Navigator

RUHMI Framework supports a GUI-based model deployment workflow via the Al Navigator in Renesas e?
studio. This section explains how to import and convert an Al model (e.g. TFLite) using the GUI, and how to
integrate it into your Renesas RA8P1 project.

Hardware Requirements

. EK-RA8P1 Evaluation Kit
. USB-C to USB-C cable
A PC with at least one available USB port

Software Requirements

*  Windows® 10 or 11 operating system. Renesas e? studio version: 2025-10
Flexible Software Package (FSP): 6.1.0 or later.
o Refer to the webpage (RA Flexible Software Package Documentation) for the details.
» Al Navigator v2.1.0 for GUI
o Visit the Al Navigator web page (Al Navigator: IDE for Al Applications | Renesas) and
download the release note. It includes the features, changes, additional notes, and more.

31 Introduction
Al Navigator is a set of plugins for e? studio that makes it easy to develop the edge Al application with
Renesas devices. One of the plugins, Al Model Conversion Tool Plugin uses RUHMI Framework to provide

Al model conversion feature.
The development steps using Al Navigator are shown below. All steps can be controlled by the Al Navigator.

Choose Al App Project o Convert Al Model
& Al Model (RUHMI)
\ onModel xm_), Wodel |
— | source |
w,/,.;, , Sample Al Application \_3 \__code /
o Choose your target Al Convertyour Al model e Edit the application
application project using RUHMI to source source code and Build it. Application on the
based on your use case. code (C/C++). Then, download it to Board,

your target board.

Figure 3.1 Al Navigator development flow
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3.2 Installation

+ New e? studio users

Download e? studio 2025-10 from the following link:

e? studio 2025-10 installer for Windows After downloading, install e? studio.

Select the following each item when installing.

- Device Family: RA

- Additional Software: Renesas Al Navigator, Al Model Conversion Tool Plugin, and Renesas FSP
v6.1.0

- e?studio users

Download and install FSP v6.1.0 or later.

Then, add the necessary plugins by following the steps below.:

1. Launch e? studio.

2. Click [Help] > [Install Renesas IDE Features...].

(Refere to Figure 3.2 Install IDE feature (1))

3. Select [Renesas Al Navigator] and [Al Model Conversion Tool Plugin].

4. Click [Finish].

(Refere to Figure 3.3 Install IDE feature (2))

5. Confirm that these plugins are selected in the "install" dialog box and click [Next].

6. Confirm these plugins are selected as the installation target and click [Next].

7. Read the license agreements and select "l accept the terms of the license agreement” if you agree.
Then, click [Finish] to start the plugins installation.

8. If the dialog of the trust certificate dialog appears during the installation, check the certificate and click
[OK].

9. After the installation is finished, e2 studio will prompt you to restart.

10.Click [Restart Now].

Note: If [Install Renesas IDE Features...] is not listed in [Help], please follow the steps below instead.
1. Click [Help] > [Install New Software...].
2. Click "Add..." and enter the following URLSs in Location.

- Al Navigator Plugin: https://tool-support.renesas.com/e2studio/ai/ai-navi

- Al Model Conversion Tool Plugin: https://tool-support.renesas.com/e2studio/ai/rz_tvm

RS

Conversion
Tool

Figure 3.2 Install IDE feature (1)
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@ Avsilable Updates m]
Available Updates ’7
Check the updates that you wish to install. ‘
Name Version Id
(g Renesas Al Navigator plugin

2.1.0v20250922-09.. com.renesas.ai.cor

Select All Deselect All

Details

<Back | Next> | Cancel

Figure 3.3 Install IDE feature (2)

3.2.1 RUHMI update from Conversion Tool

You can confirm the installation status in Conversion Tool. Open Conversion Tool from Renesas Al in the
menu.

a workspace - e studio

File Edit Source Refactor Mawgate Search Project Renesas Views Rum- Renesas Al | Window Help
~R{rianig~Q~ 0 + Conversion Tool
W) Al Navi Conversion Teol

n
Al Naw
£ ai_inference_thread_e w

B Reality Al ¥
Al Nav
[ @

Al App Select

£ wrappersh

mainc

PR -

Figure 3.4 Renesas Al menu

Conversion Tool supports the auto installation feature for RUHMI.

When RUHMI is not ready in the environment, Al Navigator will notify you RUHMI to be installed. By clicking
the button of setup Environment, RUHMI will be installed automatically.

0 [ Comvaran ol =
JE ® >

Conversion

Tool
@ gt FileSeting
-_T;" 2 Optimaae

Figure 3.5 Auto installation

Conversion Tool also supports the auto update feature for RUHMI. If the latest package of RUHMI has been
available in the GitHub repository, Conversion Tool will notify the ready-ness. (Figure3.6 Update feature)

Get RUHMI updated by clicking the update button. The update procedure will start automatically.
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D AN weruon - n
Conversion ¥
Tool =

RUHMI Framework Al Compder v Jaste avadstie |

e Sert
— brameaca seie
-_q.—_ 2. Opuenuzavion ONNXL o O TersorFiow Ltel e
ooy’ Np
eret v2_TA Browse

Figure 3.6 Update feature

In case no longer RUHMI is needed, you can uninstall RUHMI Al compiler by clicking the Uninstallation
button. (Figure 3.7 RUHMI Uninstallation)

D Al Now omwersion Wo =

Project name

Conversion s .o it B e §
Tool RABP1 (CPUEthos-USS '

RUHM: Framework Al Compier

Framework selection

2. Opomizanon © ONNXLon Tensorfiow Lite( tite)

ExecuTorch( pte

3. Conversion
Input moded the

YRR

Output directory
conversion resudts Browse

Next >

Figure 3.7 RUHMI Uninstallation

3.2.2 How to confirm the version of Al Navigator

You can confirm the version of Al Navigator installed in your host by following steps. Open the dialog
providing detailed information for e2Studio from HELP menu in e2Studio.

Project Reresss\iews Run Renesas Al Window Help

Qv o % Welcome C/Ces £33 FSP Configu
Dane  [Bcomersion ool X (&) haientryc (3) Help Coments = g
;V&}](‘(T'u ¥ Search
. Show Context Help v
Conversion
Dewice Show Active Keybindings. Cirl+Shift+l
Tool B9 Chest Sheets v
Tools
Renesas Help )
Toolchain Help >

@ 1. Inpet File Settings CMSIS Packs Management >

Add Renesas

Framews @ Eclipse User

— 3
s et ey OONN 53 Perform Setup Tasks

Pylon
Check for Updates

% 3. Conversion & Imtal New Software.
reut moc
! y & Eclipse Marketplace

Instad Rerwsas 1DE Features.

OQuipet dit i AR Embedded Workbench plugin managec

& Avoute studio l

Next™

Figure 3.8 Help menu
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Click the button of Installation Detail. Figure 3.9 Check the installation detail.

TS & SURNG

Version: 2025-07 (25.7.0)
Burld i: R20250717-1000

e 2 Parts Copyright (C) 2010-2025 Renesas Electronics Corp

All nights reserved.

¢ stuchio IDE 5 an extension of software developed for
eclipse.org

¢’ studio 1DE 15 based on Echipse Matform 4.35 (2025-03)
and COT version 1200,

Source code for the Eclipse Foundation plug-ins is available
from www.edhpse.org, under the Eclipse Public License "EPL”
see hitps//www.eclipse org/org/documents/epl-2.0/EPL-2.0 htm
and https,//www.edlipse org/org/documents/epl-v 10.hem

comzmemoeczocme

Figure 3.9 Check the installation detail

You can see the version information of Al Navigator installed in your host as below.

-
Installed Software  Installation History Features| Plug-ins Configuration Renesas Device Support| Support Folders
P ai *
Name Version [}
Lk Al Model Comversion Toal 2.1.0,20250929-0251 comrenesas.ai.drptranslatorfeatun
~ K Reality Al Utilities 2.3.0.520250806-0801 comurenesas.ai.datastoragetool fe
> Wj= Renesas e2 studio Reality Al Core 25.7.0.v20230619-0529 comurenesas.e2studio.tools.realitya
[ %% Renesas Al Navigator plugin 2.10520251002-0524 | com.renesas ai.common feature fe
ik Renesas e2 studio Reality Al Core 25.7.0v20250619-0529 comurenesas.e2studio.tools.realitya
~ ik Renesas e2 studio Reality Al for Renesas RA 25.7.0020250619-0529 com.renesas.e2studio.toolsreality.
» Wik Renesas 2 studio Reality Al Core 25.7.0w20250619-0529 comurenesas.e2studio.toolsrealitya
~ Wk Renesas e2 studio Reality Al for Renesas RLTS 25.7.0520250619-0529 comurenesas.e2studio.tools.realityy
» W= Renesas 2 studio Reality Al Core 25.7.0.v20250619-0529 comurenesas.elstudio tools.realitya
w Wk Renesas e2 studio Reality Al for Renesas RX 25.7.0v20250619-0529 comurenesas.e2studio.tools.realitya
» Wk Renesas e2 studio Reality Al Core 25.7.0v20250619-0529 comurenesas.e2studio.tools.realitya
~ Kk Renesas e2 studio Reality Al for Renesas RZ 25.7.0v20250619-0529 com.renesas.e2studio.tools.reality:
» gk Renesas 2 studio Reality Al Core 25.7.0,20250619-0529 comurenesas.e2studio.tools.reality

Renesas Al Navigator plugin

A
@ Update._. Uninstall.. Praperties [ crose

Figure 3.10 AV Navigator version

3.3 Getting Started

This section explains how to integrate an Al model into your project with Al Navigator, including model
conversion using RUHMI Framework on GUI.

The following figure shows the workflow from opening to running on the board. It includes Al model
conversion using RUHMI Framework.
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[ 1. Open Al Navigator ]
[ 2. Import an Al application project ]
[ 3. Convert Al Model ]
[ 4. Edit Application ]
[ 5.Run on‘the Board ]

Figure 3.11 Al Navigator Workflow

3.3.1 Open Al Navigator
Open e? studio and your workspace.

Click [Renesas Al] as shown in the figure below to launch Al Navigator and Conversion Tool.

BB vorkspace - £¥ studio

File Edit Sowrce Refactor Nawgate 5Search Project Renesas Views Rom Renesas Al|l Window Help
~Rorim ity Qi | Conversion Tool
e
Lo

i
)
1
]
L]

&

D ainavi % B Conversion Tool ¢ wrappers.h ¢ ai_inference_thread D AlNav mainc
E Reality Al »
Al Navi
Al App Select

Figure 3.12 Opening Al Navigator

Al Navigator
This application provides you with selecting either sample application (Al application example) run and your
project with your own converted model.

Conversion Tool:
This application provides the model conversion function with your own model input.

A dialog box may appear asking you to switch perspectives. If you accept, click “Switch” to continue.

e’ Switch perspective

This Renesas Al perspective is designed to support using Al Navigator.

Do you want to open this perspective now?

(] Always use this setting.

T

Figure 3.13 Switch perspective dialog box

Al Navigator will open.
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o) Al Navi X

Al Navi
Al App Select

Run on the Board

RENESAS

Al Navigator

Learn mare...

Create New Al with...

Select Sample Use Your Project
Al Application & Al Model
Select Al Application Select Project
Transfer Leaming Select Al Mode
Convert Convert
Build
Run Run

Project:

vision_ai_ethosu_mipicsi_gled_ek_ralp1_llvm_mera_yolo_fastest Centinue

Figure 3.14 Al Navigator Welcome View

Note: If the Appearance Theme is set to "Light (Preview)", some GUI components such as buttons may not

be displayed correctly.

Please change Theme to "Light" or "Dark" from [Window] -> [Preferences] -> [General] -> [Appearance].
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3.3.2 Import Al application Example
There are two ways to import a project.
+ Select Sample Al Application (Al application Example)

» Use Your Project & Al Model

3.3.2.1 Select Sample Al Application (Al application Example)
With EK-RA8P1, it can run the following two Al application examples.

» Image classification
+ Face detection

Using Al Navigator, you can import them into your workspace and run them onto the target board.
Follow the instructions below to import.

Click [Select Sample Al Application].

Select a category of sample Al application (Al application Example) based on your case.
Choose sample Al application (Al application Example).

Click [Import].

The Project and Al information view like below will appear if the import is successful.

arON =

QD Al Navi X =5

Al Navi (€] Successfully imported the Al application

A Al applications are provided with pre-trained Al models.

P rormaton

Run on the Board

. . Project: vision_ai_ethosu_mipicsi_glcd_ek ra8p1_livm_mera_yolo_fastest
- Device: RABP1

-----

Target Board: EK-RA8P1

Al Information

@ Al Application: Face detection [ Edit and Build...
Al Model: Yolo-fastest

Task:
Accuracy:

Dataset:

RENESAS

Figure 3.15 Project and Al information view

In case you just want to run the Al application example, click [Run on the Board] in the Al Navigator menu.
(See 3.3.5 Run on the Board)

If you want to convert an Al model, click [Edit and Build...] in Al information to appear [Convert Al Model]
in the menu.
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3.3.2.2 Use Your Project & Al Model

Al Navigator also provides the user project feature that allows users to develop Al Applications using your
own projects, including own Al model. Follow the instructions below to prepare and import your project and
Al model.

1. Create or import an RA8P1 e? studio project into your work space.
Note: Refer to RA Flexible Software Package Documentation for information about FSP project.
Note: Add the following stacks if you use Ethos:

— Google TFLM Core Lib
- Google TFLM CMSIS-NN Kernel

Once added, the required dependent stacks (such as ARM Ethos-U Core Driver, ARM CMSIS NN
Library Source, ARM CMSIS DPS Library Source) will be included automatically. You can refer Using
the Ethos-U NPU with RA8 MCUs to get more information.

2. Click [Use Your Project & Al Model] in the Al Navigator Welcome View.
3. Select your project prepared in 1. and click [Finish].

=] O X

Select BYOM project

Select the project you want to use as BYOM project. BYOM supports only RABP1.

ainavi_ra8p1_sample

Figure 3.16 Select your project window

4. Click [Use Al Model on Your PC].

Select your own model or a model from the Model Zoo.

Use Al Model
on Your PC

=

Figure 3.17 Use Al Model on Your PC

5. Select your Al model (*.tflite / *.onnx / *.pte).
Note: Please avoid using spaces in your Al model name. The Al model conversion may not succeed.

6. The Project and Al information view will appear when the project and Al model are imported successfully.
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Project Information
Al App Selec . " Project: ainavi_raBp1_sample
Convert Al Model -.' Device:

RABP1
Edit Application

Target Board:
Run on the Board

Al Information

@ Al Application: 7] Edit and Build...
Al Modek: yolo-fastest_192_face_v4 lite

Task:
Accuracy:

Dataset:

Figure 3.18 Project and Al information view (Use your project & Al model)
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3.3.3 Conversion
After the setup, click [Convert...] and Conversion Tool will open.
Follow below three steps to convert Al model once Conversion Tool opens. These steps are also shown
in the left-side menu in the figure (Figure 3.19 Conversion Tool).

(1)  Input file settings
(2)  Optimization
(3) Conversion

(1) Input file settings

With reference to Figure 3.19 Conversion Tool, please set the following settings in this view. After setting,
click [Next].

. Project name: Select your project.
. Device:  Set your device
You can see two options in the pull-down menu as Figure 3.20 Device setting.
- RA8P1 (CPU+Ethos-U55):  Using RA8P1

- RA8 series (CPU only): RA8 series MCU without Ethos-U55
. Tools: RUHMI Framwork Al Compiler
. Framework selection: Select your mode framework.
ONNX (.onnx), TensorFlow Lite (.tflite), PyTorch(.pth/.py), ExcuTorch(.pte)
. Input model file:  Click [Browse] and select your target Al model.
You can select the model file of the your selected framework type.
. Output directory: Specify the output directory for the conversion result.

You cannot put any space in the folder name.

8 workspace - ¢ studio

File Edit Source Refactor Nawigate Search Project RenesasViews Run Renesas Al Window Help

O-A-iNi%-Q-iO Q 9| Bhc/Ces ) FSP Configut
\{) Al Navi Corwersion Tool X =
Project name
Conversion vision_ai_ethosu_mipicsi_glcd_ek_ra8p1_livm_mera_combined v
Dewice
Tool RABP1 (CPU+Ethos-USS) -
Tools

FUHMI Framework Al Compiler v &  Installed E Uninstall

1. Input File Settings

Framework selection
2. Optimization © ONNX(.onnx) TensorFlow Lite( tflite)

ExecuTorch(.pte)

3. Conversion

L ik

Input model file

Browse

Output directory

conversion_results Browse

Next >

Figure 3.19 Conversion Tool

Device
RABP1 (CPU+Ethos-U55)

RABP1 (CPU+Ethos-US3)
RAS Series (CPU Only)

Figure 3.20 Device setting
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(2) Optimization

In this view, you can perform quantization as needed to prepare your Al model into an optimized format.

If you select a quantized model as the input model file in the previous view, confirm that the message
indicating a quantized Al model was loaded in Quantization result, and click [Next]. ( Optimization (input file:
a non-quantized model))

If you select a non-quantized model, perform quantization in this view. Set each parameter and click [Start
quantization]. If quantization is successful, a message as shown in Figure 3.22 Optimization (input file: a
non-quantized model) will appear. Click [Next] to continue.

Note: Click [Learn more] in this view and open Al Model Conversion Tool Help.
Refer to View 2: Optimization (Quantization) for the details about quantization.

i) Al Ma M corverson Roal =

Crveraew

co nve rsion CuanliEing The model enables procesang on Ethet
o
Tool > >
X X -
1. Inpant File Sattings . .
sl [ L

2. Opbemnizateon Cuantizatson settngs
Select input node Learm More.

T - coroton data cwectory (Rexomenended: Set directony 10 masntam sicuracy)

3. Comwersion

P it &

Set the normalization parameters for input images

Parameter Value

Quantization result

Ia quantized model has been loaded I

Nest =

Figure 3.21 Optimization (input file: a quantized model)

OANsv [ Conversion Tool =
Conversion Quantizing the model enables peocessing on Ethos ;
Tool &« o @ o
. ® ——@ ]
SR o senge
* e ® ® @ ®
= o

Figure 3.22 Optimization (input file: a non-quantized model)
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(3) Conversion
Configure the following options as needed before conversion.

The optimization options depends on the conversion mode.
Case 1) Use CPU+ Ethos-U55
*  Optimize mode:
- Performance: (default) Optimize for maximum performance.
- Size: Optimized for minimal RAM usage.
*  Memory mode:
- Sram_Only: (default) Specify when placing weights in the internal ROM.
- Shared_Sram: Specify when placing weights in the external ROM.

Case 2) Use CPU only
*  Weight location (*for using CPU only) :
- ROM: (default) Neural network weight data is stored in ROM.
- RAM: Neural network weight data is stored in RAM.

Additional options:
Click [Browse] and select your target Al model.
) Al Naw =0

-l.;'E’P.’_“.'-"_ S available when selecting Use CPU+ Ethos-US5
Conversion Use CPU<E thos-L5S

Tool

ormance: (default) Optimize for marimum performance

nly: ddefautt) Specity when placing wei

1. Ingant File Settings

2. Optinization

P

Comverson result

Figure 3.23 Conversion options

After setting options, click [Start conversion]. If the conversion is successful, a message indicating
success will appear in the Conversion Result section, as shown in the figure below.

You can see the conversion log in the folder which you can open by clicking the button. The log file there
should be helpful to get the support from Renesas.

D Al Nav rwersion Tool -

Conversion
Tool

Figure 3.24 Conversion completed
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3.3.4 Edit your application

After conversion, edit your application source code including the implementation of Al model (C/C++), and
build your project.

@D Al Navi X =8
AI NaVi Al Application
1. Build Settings
E\I] n
Set up building environment for Al application. How to Implement Al model...
Al App Select
Convert Al Model 2. Build Al Application ™ Edit...
Edit Application Build the application after setting up the build environment. &, Build

Run on the Board

Figure 3.25 Edit Application

-_—

. Click [Edit Application] in the Al Navigator menu.

2. Click [How to Implement Al Model...] to open “How to Implement Al model”. This document describes
the steps from integrating the converted output code via RUHMI Framework to executing Al inference.

3. Modify the source code. When clicking [Edit...], hal_entry.c will open. Integrate the Al model.

4. Click [Build]. The build result will be shown in the console.

R11QS0065EJ0101 Page 22 of 32
Oct. 31 2025 RENESAS



Renesas RA Family Renesas RUHMI Framework — Quick Start Guide

3.3.5 Run on the Board

D Al Navi X

Al Navi Debug Seting:
R

Al App Select

Run the Al application on the board.

O Run theﬂi

Run on the Board

Figure 3.26 Run on the Al

To run your Al Application on the target board,

1. Connect EK-RA8P1.
2. Click [Run on the Board] in the Al Navigator menu.
3. In the Debug Al view, click [Run the Al] to start inference.

Note: When you try to run an RA8P1 Al application example via the [Run the Al] button, the build process will
start automatically before debugging. To skip this auto build:

1. Open Debug Configurations.

2. Select your project in Renesas GDB Hardware Debugging.

3. Go to Main tab.

4. Choose “Disable auto build” or “Use workspace settings” in Build (if required) before launching.
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4. Running the sample script by CLI interface

Without GUI interface provided by Al navigator, you can use RUHMI framework to convert Al model with CLI
interface from the GitHub repository. You can install RUHMI with CLI interface supported by manual
insulation following the coming section.

renesas/ruhmi-framework-mcu: Renesas RUHMI Framework supports Al model optimization and
deployment, and is powered by EdgeCortix® MERA™

41 Software Requirements

. Windows® 10 or 11 operating system or Ubuntu 22.04 LTS.
. Flexible Software Package (FSP): 6.1.0

4.2 Downloading and Installing Software and Development Tools

Before modifying or running the sample scripts, it is necessary to download and install the required software
and development tools on the host PC. RUHMI Framework supports installation and usage in the following
environments:

Interface
Type

Linux (Ubuntu 22.04)  CLI

Platform Description

Full-featured environment. Recommended for advanced users and

automation.
Windows CLI Swtgblt_—:‘ for scripting and model testing. Requires Python + VC
Redistributable.
: R : . . oL
Windows GUI Isrgﬁjgprated into e? studio. Ideal for beginners and visual, step-by-step

421 Linux CLI Installation

Get the installation file from GitHub and place it in your PC.

GitHub repository: ruhmi-framework-mcu/install at main - renesas/ruhmi-framework-mcu
Installation files for Linux: mera-x.y.z+pkg.nnnn-cp310-cp310-manylinux_2_27_x86_64.whl

NOTE: x, y, z and nnnn mean the version number.
(e.g. mera-2.4.0+pkg.1756-cp310-cp310-manylinux_2_27_x86_64.whl)

Update the package index to ensure your system has the latest information about available software
packages. and installs essential development tools such as GCC, and Make (build-essential), along with
CMake, which is a tool used to manage build processes for compiling source code. Run the following
commands:

sudo apt update

sudo apt install build-essential cmake python3-venv python3-pip

Recommended: use the default Python installation
Because MERA™ software stack is compatible by default with the base system Python version provided by
Ubuntu 22.04 we can create a virtual environment as follows:

sudo add-apt-repository -yu ppa:ubuntu-toolchain-r/test
sudo add-apt-repository ppa:deadsnakes/ppa

sudo apt update && sudo apt upgrade

sudo apt-get install -q -y --only-upgrade libstdc++6 libgcc-s1
sudo apt update && sudo apt upgrade

sudo apt build-essential gcc-13 g++-13

sudo apt-get install python3.10 python3.10-venv python3.10-dev python3-pip

python3.10 -m venv mera-env

source mera-env/bin/activate

pip install --upgrade pip && pip install decorator typing_extensions psutil attrs pybind11 cmake
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Your prompt should now show that you are under a virtual environment mera-env: (mera-env)
user@compute:~$

Install MERA
Finally install MERA on the virtual environment mera-env:

NOTE: In this case, the installation file is “mera-2.4.0+pkg.1756-cp310-cp310-manylinux_2 27 x86_64.whl”.
The suffix number of the file depends on the package version.

At this point MERA should be ready to use. You can confirm with the following example:

python -c "import mera; print(mera.__version__ )"
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4.21.1

Download the Microsoft Visual C++ Redistributable

Note: You must download vc_redist.x64.exe since RUHMI Framework’s MERA™2.0 backend only supports
X64 architecture PCs

* Run the download exe file to install Redistributable package.
Microsoft Visual C++ Redistributable latest supported download

Install Python 3.10.5
Download Python installer, Windows installer (64-bit), from Python Release Python 3.10.5 | Python.org.
Then install it on your PC.

Open PowerShell from the windows start menu. Create and move it to the working folder. Assuming
C:\work is the current folder in the following process. You can confirm python is ready with the intended
version.

PS <current directory>> cd C:\work

PS C:\work> python --version
Python 3.10.5

Prepare the virtual environment.
Build the virtual environment under the working directory.

py -3.10 -m venv .venv

Before activating the virtual environment, you may need to change the execution policy for shell execution.

Set-ExecutionPolicy -ExecutionPolicy RemoteSigned -Scope Process

.venv\Scripts\Activate.ps1
Your prompt should now show that you are under a virtual environment mera-env: (.venv) PS C:\work>

Install MERA backend and dependencies
Get the installation file from GitHub and place it on your PC.

GitHub repository: ruhmi-framework-mcu/install at main - renesas/ruhmi-framework-mcu
Installation files for Windows: mera-x.y.z+pkg.nnn-cp310-cp310-win_amd64.whl

NOTE: The file name may vary depending on the release version. X, y, z and nnn mean the version number.
(e.g. mera-2.4.0+pkg.179-cp310-cp310-win_amd64.whl)

To configure the environment variables for e2studio, the following command is needed.

[Environment]::SetEnvironmentVariable(CONVERSION_TOOL_E2STUDIO_PLUGIN_PYTHON_VENV_

LOC', "$(Get-Location)", 'User')

Put the installation file in the working directory.

In PowerShell, run the following commands to install MERA. The file name should be as the actual name in
our place. The suffix of the installation file may vary depending on the release version.
python -m pip install .\mera-x.y.z+pkg.nnn-cp310-cp310-win_amd64.whl

python -m pip install onnx==1.17.0 tflite==2.18.0

You can confirm the installed RUHMI release version, vera version and all your path settings of your
environment by the following commands.
python -c "import mera; print(mera.__version_ )
2.4.0+pkg.179

]

vela --version
4.2.0
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4.3 Using Sample script for Linux and Windows CLI

RUHMI Framework provides Python-based command-line tools to help users deploy Al models on Renesas
RA8 MCUs with or without acceleration by Arm® Ethos-U55. The sample scripts are:
e mcu_deploy.py: for deploying non-quantized (FP32) models
e mcu_quantize.py: for quantizing models and deploying optimized C code
Both scripts support additional options for reference data generation and memory configurations.
You can get the sample scripts from ruhmi-framework-mcu/scripts at main - renesas/ruhmi-framework-mcu.

431 Compiling Non-Quantized Models
To deploy a pre-trained model without quantization:

python scripts/mcu_deploy.py --ethos --ref _data models/ output_dir/

| Option || Description

|—-ethos ||Enables code generation for Arm Ethos-U55

|models/ ||Directory containing .tflite model files

|
|
|——ref_data ||Generates input/output .npy files for testing |
|
|

|output_dir/||Output folder where C code and test data are saved

4.3.2 Quantizing and Compiling Models

To quantize a TFLite, ONNX, or Executorch (.pte) model and compile it for MCU:.
Example command:

python scripts/mcu_quantize.py models_fp32/ compiled_models/ -c 5 --ethos --ref data

| Option || Description |
|—c, --calib_num ||Number of random samples used for calibration (default: 5)|
|--ethos ||Target Arm Ethos-U55 for accelerated subgraphs |
|——ref_data ||Generate C99-format reference input/output for validation |

|mode|s_fp32/ ||Input folder with FP32 models (.tflite, .onnx, .pte) |

|compi|ed_models/||Output folder for quantized and compiled results |

44 Deployment Output Structure

After running the scripts, the following folder and file structure will be generated for each model. These
represent the C source code, headers, and supporting files necessary to integrate the model into an MCU
project.

deploy/
— person-det_no_ospi
— build
L—mMmcu
— compilation
—— mera.plan
—— Src
—— compute_sub_0000.c [Copy onto your source folder]
—— compute_sub_0000.h [Copy onto your source folder]
—— ethosu_common.h [Copy onto your source folder]
hal_entry.c [NOTE] This is just a reference and NOT needed copied.
—— kernel_library_int.c [Copy onto your source folder]
—— model.c [Copy onto your source folder]
—— model.h [Copy onto your source folder]
—— model_io_data.c [Copy onto your source folder]
—— model_io_data.h [Copy onto your source folder]
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—— sub_0001_command_stream.c [Copy onto your source folder]
—— sub_0001_command_stream.h [Copy onto your source folder]
—— sub_0001_invoke.c [Copy onto your source folder]
—— sub_0001_invoke.h [Copy onto your source folder]

—— deploy_cfg.json

—— ir_dumps

person-det_can.dot
—— person-det_after canonicalization.dot
—— person-det_subgraphs.dot
—— logs
—— model
L_‘— input_desc.json
project.mdp

You will copy all files under the folder of <deployment_directory>/build/MCU/compilation/src. other than
hal_entry.c onto your source folder.
Please note that the file names and the number of files depend on the input model and the conversion mode.

4.5 Generated inference API (Ethos-U Enabled)

If Ethos-U support is enabled during conversion into source code with the compiler then an arbitrary number
of subgraphs for either CPU or Ethos-U will be generated. Each of these subgraphs will correspond to
generated C functions to run the corresponding section of the model on CPU or Ethos. Each function call will
get its input from previous outputs of other subgraphs and write its outputs on buffers that are designated to
become again inputs to other functions and so on. To make easier for the user to invoke these models
where CPU and NPU are involved, the generated code will automate this process and provide a single
function that will orchestrate the calls to the different computation units named void RunModel(bool
clean_outputs) and helpers to access to each of the input and output areas at model level not per subgraph
level. The runtime API header where Ethos-U is enabled can be found on a file named model.h under the
same directory <deployment_directory>/build/MCU/compilation/src.

Example 1: Definition of input/output buffers (in the file of model.h)

void RunModel(bool clean_outputs);

/l Model input pointers
float* GetModellnputPtr_input_1();

/l Model output pointers
float* GetModelOutputPtr_Identity 70029();

Example 2: Source code

memcpy(GetModellnputPtr_input_1(), model_input0, model_input_SIZEOQ);

//Set the input model to the pointer for the compiler

/IWill be set the output data to the GetModelOutputPtr_ldentity _70029()
RunModel(); //Execution

4.6 Generated inference API (CPU-Only)

When a model is converted into source code with RUHMI framework without Ethos-U support, all the
operators in the model are mapped to run on CPU only. In this case, the generated code will refer to a single
subgraph compute_sub_0000, by default, when no suffix is provided, the name of the header to be included
on your application entry point is defined in compute_sub_0000.h.

This header, model.h, provides the declaration of a C function that if called will run the model with the
provided inputs and write the results on the output buffers provided.
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Example 3: Definition of input/output buffers (in the file of model.h)

enum BufferSize_sub_0000 {
kBufferSize_sub_0000 = <intermediate_buffers_size>

%

void compute_sub_0000(
/I buffer for intermediate results
uint8_t* main_storage, // should provide at least <intermediate_buffers_size> bytes of storage

[/ inputs
const int8_t <input_name>[xxx], // 1,224,224,3

// outputs
int8_t <output_name>[xxx] // 1,1000

Example 4: source code

int8_t output_buffer[1000]; //StatefulPartitionedCall_0_70016;

compute_sub_0000(compute_buffer, input_buffer, output_buffer);

5. Website and Support

Visit the following URLSs to learn about the kit and the RA family of microcontrollers, download tools and
documentation, and get support.

Renesas Atrtificial Intelligence (Al) renesas.com/ai

Al Navigator renesas.com/software-tools/ai-navigator
RA Product Information renesas.com/ra

MCU Evaluation Kit renesas.com/ra-kits

RA Product Support Forum renesas.com/ra/forum

Renesas Support renesas.com/support

Provide Feedback/ Request a Feature

Renesas aims to provide the best microcontroller kit experience to help jumpstart customer innovation with
RA, RX & RL78 family of microcontrollers and take products to market faster. The Renesas microcontroller
kits have been designed with a lot of attention-to-detail and customer-centric thinking in every aspect of
design. Renesas aims to exceed customer expectations.

Renesas looks forward to hearing your feedback and knowing how we can enhance your experience. Please
share your feedback at renesas.com/ra/kitfeedback & renesas.com/rx/kitfeedback.
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